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2.13 Exercises

Solutions and input files can be found at http://familias.name.

Exercise 2.1 (Simple paternity case. Video).

The purpose of this exercise is to illustrate the basic concepts based on a

simple paternity case. Figure 2.6 shows a mother (undisputed), an alleged

father (AF) and a child.

Figure 2.6: A standard paternity case with genotypes for two markers, see

Exercise 2.1.

We consider

H1: The alleged father (AF) is the biological father. 

H2: The alleged father and the child are unrelated. The

mother is undisputed.



64 CHAPTER 2. BASICS

a) Consider first only one autosomal locus, called S1, with alleles A, B and

C, as displayed in Figure 2.6. The allele frequencies are pA = pB = 0.05

and pC = 0.9. Explain why the likelihood ratio is LR = 1/pA. How do

you interpret the LR?

b) Calculate the LR using Familias.

c) There is a second autosomal locus, called S2, with alleles a, b, c and d

with allele frequencies 0.1, 0.1, 0.1 and 0.7, respectively. Calculate the

likelihood ratio for this marker and also for the two first markers combined

using Familias.

d) It can be shown that the likelihood ratio for two first markers is (1/pA)×
(1/pB). Use this to verify the Familias answer calculated above.

e) Generate a report clicking Save results with options

Only report, Rtf report, Complete. The report includes all input

and all output. Check that the report file is correct and contains sufficient

information to reproduce the calculations. In particular check that the

LR for markers S1 and S2 and the combined likelihood.

f) Save the Familias file (we suggest the file extension fam). Exit Familias.

g) Start Familias and read the previously saved file. RMP abbreviates the

random match probability. Calculate 1/RMP for AF by hand and in

Familias. Hint : Mark AF in the Case-Related DNA data window and

press Compare.

h) We next consider theta (θ) correction. For simplicity we will only use

the first marker, S1. The θ parameter is called kinship parameter in
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Familias and is set using the Options in the Pedigrees window. Set

the kinship parameter to 0.02. Calculate the LR for the first marker S1.

To get calculations for selected markers only, in this case S1, use the

Included systems button. Check that your answer coincide with the

following theoretical result

LR =
1 + 3θ

2θ + (1− θ)pA
. (2.18)

i) Discuss the assumptions underlying the calculations of this exercise.

Exercise 2.2 (Simple paternity case with mutation).

We consider a motherless paternity case, see Figure 2.7, with one marker,

VWA.

AF
14/15

Mother
−/−

Child
16/17

Figure 2.7: A paternity case with possible mutation.

The allele frequencies are given in Table 2.8. The alleged father is 14/15,

the child 16/17 while the hypotheses are as in Exercise 2.1.
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Allele Frequency

14 0.072

15 0.082

16 0.212

17 0.292

18 0.222

19 0.097

20 0.02

21 0.003

Table 2.8: Allele frequencies for Exercise 2.2

a) Explain why LR = 0. Confirm this answer using Familias.

b) Use the mutation model “Equal probability” with mutation rate R =

0.007 for both males females and calculate LR.

c) It can be shown (see Exercise 2.8) that

LR =
m(p16 + p17)

2p16p17
. (2.19)

Use this formula to confirm the Familias calculation. Obtain m, the

probability of mutating to one specific allele, using File > Advanced options.

Explain the difference between R and m.

Exercise 2.3 (Missing sister).

The College of American Pathologists (CAP) has several proficiency testing

programs targeted to laboratories that perform DNA typing of STR loci.

The below is a test from 2011: Hikers come across human skeletal remains
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in a forest. Evidence around the site provides a clue as to the identity of the

individual. You are asked to test a bone to determine if the individual (bone)

is related to an alleged mother (AM) and the mother’s other daughter, the

alleged full sister (AS,) see Figure 2.8.

AF
−/−

AM
6/8

Bone
6/9

AS
6/9

Figure 2.8: The case of the missing sister. The alleles (allele frequencies) are

6 (0.086), 8 (0.152) and 9 (0.328) for this marker (F13B).

The hypotheses are

H1 : The bone belonged to the daughter of AM and sister of AS.

H2 : The bone belonged to someone unrelated to AM and AS.

a) Enter the data manually and calculate the LR. The genotypes and allele

frequencies for this marker (F13B) are given in Figure 2.8.
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b) Read input from the file Exercise2_3.fam. Calculate the LR based on

all markers.

c) Find the LR–s of the individual markers. Check that the answer for F13B

corresponds to the one you found in problem a) above.

d) One of the markers, D7S820, gives a very large LR, namely 11189. What is

the reason for this large LR? What is the combined LR if marker D7S820

is removed?

Exercise 2.4 (Grandfather - grandchild).

Two individuals, GF and GS, are submitted to the laboratory for testing.

The alternatives are

H1 : GF is the grandfather of GS.

H2 : The individuals GF and GS are unrelated.

Figure 2.9 shows the pedigree corresponding to H1 for the first marker

D3S1358.

a) Enter the data given in Figure 2.9 for D3S1358 manually into Familias

and calculate the LR for the first marker shown in Figure 2.9.

b) Calculate the LR based on all markers. Read input from the file

Exercise2_4fam.

c) Formulate a conclusion. In the CAP exercise it was stated that GF and

GS share the same Y-haplotype and that the frequency of this haplotype

is 0.0025. Can this information be used?
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GF
14/15

GM
−/−

father
−/−

mother
−/−

GS
15/17

Grand father alternative

Figure 2.9: Grandfather-grandchild. The alleles (frequencies) for D3S1358

are: 14 (0.122), 15 (0.258) and 17 (0.197).

Exercise 2.5 (Simple paternity case. Probability of paternity).

We revisit Exercise 2.1. Rather than calculating the LR we will now calculate

the Essen-Möller index W defined as the probability of H1 conditional on the

genotypic data. Assume a priori that the hypotheses H1 and H2 are equally

likely. Then, it can be shown that

W = Pr(H1|data) = LR

LR + 1
. (2.20)

a) Recall that LR = 20 for the first marker. Calculate W.

b) Recall that LR = 200 for two markers. Calculate W.

c) Use Familias with Exercise2_1.fam to calculate W for the two above

cases.
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d) Do you prefer LR or W?

Exercise 2.6 (Inbreeding. LR. Several alternatives).

Consider the following hypotheses

H1 : AF, the father of mother (undisputed), is the father also of her child.

H2 : An unrelated man is the father of the child.

Figure 2.10 shows the pedigree corresponding to hypothesis H1. The allele

frequencies are p1 = p2 = p3 = 0.05.

a) Use Familias to calculate the LR based on the genotypes given in Fig-

ure 2.10. (You are encouraged to enter the data manually, but there is

an input file Exercise2_6.fam available.) Does the incest influence the

resulting LR in this particular case?

The defense claims that one should rather consider the hypothesis

H3 : The brother of mother is the father of the child. See Figure 2.11.

The LR can be calculated in several ways depending on the choice of the

reference. Calculate LR(H1/H2) and LR(H1/H3).

b) When there are more than two hypotheses, as above, some prefer to rather

calculate posterior probabilities for the hypotheses as there is then no

need to define a reference (or denominator) pedigree. Assume that each

of the three hypotheses are equally likely a priori. Calculate the posterior

probabilities.

theg
Gjennomstreking
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AF
1/2 −/−

AF
1/2

mother
1/3

child
1/2

Figure 2.10: Incest by father. The stapled line indicates that AF appear in

two roles. See Exercise 2.6.

Exercise 2.7 (Several mutation models).

In this exercise, which extends on Exercise 2.2, we will try the different

mutation models. The models are described in detail in Section A.1.4 of the

manual available from http://familias.no. Throughout we consider data

from the system VWA given in Exercise 2.2. The alleged father is 14/15 and

the child 16/17 while the hypotheses are

H1 : The alleged father is the true father.

H2 : The alleged father and child unrelated.
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AF

brother mother

child

Figure 2.11: Incest by brother. A standard way of displaying incest is used

in the figure. See Exercise 2.6.

There are five different mutation models in Familias. In this exercise all

will be tried. We will use overall mutation rate R = 0.005 and the same

model for females and males. The answer for this exercise will be obtained

using Familias; Exercise 2.8, on the other hand, is based on theoretical

calculations.

a) Load the data Exercise2_7.fam. Use the Equal probability model.

Calculate the LR. (Answer: LR = 2.9e−03 = 0.0029. comment : For this

model mutations to all other alleles are equally likely).

b) Use the Proportional to freq. model. Calculate the LR. (Answer:

LR = 6.3e − 03 = 0.0063. Comment : For this model it is more likely to

mutate to a common allele compared to a rare).
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c) Use the Stepwise (Unstationary) model. For this model there are two

parameters. The first is as before and should be set to R = 0.005. Set

the second parameter, Range to r = 0.5. Calculate the LR. (Answer:

LR = 4.7e − 03 = 0.0047. Comment : For this model, mutation depends

on the size of the mutation. With r = 0.5, a two step mutation occurs

with half the probability of a one-step mutation. A three step mutation

occurs with half the probability of a two step mutation and so on. The

value r = 0.1 may be more realistic.)

d) Use the Stepwise (Unstationary) model with parameters as above.

(Answer: LR = 6.4e− 03 = 0.0064.)

e) Use Extended stepwisemodel with last parameter 0.1. In this case, with

no microvariants, the results is the same as for Stepwise(Unstationary)

regardless of values of last parameter.

Comment : The models Proportional to freq. and

Stepwise (Stationary) are stationary, the others are not. If a model

is stationary, introducing a new untyped person, say the father of the

alleged father, does not change the LR. This is a reasonable property of a

model as introducing irrelevant information should not change the result.

For an unstationary model, however, the LR will change slightly as allele

frequencies may then differ from one generation to the next. While this

may appear mathematically inconsistent, it could be argued that allele

frequencies change, i.e., a stationary distribution has not been reached.

f) Verify by means of an example that the LR does not change if a father

of the alleged father is introduced for the stationary models, while slight

theg
Gjennomstreking
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changes occur for the two other models.

g) Comment : There is an other subtle point of all mutation models: In this

case only five alleles (14, 15, 16, 17 and “Rest allele”) are needed rather

than the 8 alleles defined. A five allele model will lead to slightly changing

LR-s. Verify the above and comment.

Exercise 2.8 (*Mutation models, theoretical).

In this exercise, which serves to confirm the answers obtained in Exercise 2.7,

we will fill in some mathematical details related to the mutation models.

a) Show that

LR =
p16(m14,17 +m15,17) + p17(m14,16 +m15,16)

4p16p17
(2.21)

where p16 is the allele frequency for allele 16 and m14,17 the probability of

a mutation from 14 to 17 and so on; the formula is a special case of (2.12).

b) For the “Equal probability” model mij = m = R/(n− 1), where n is the

number of alleles. Explain why Equation (2.19) in Exercise 2.2 follows

from (2.21). Show that when n = 8 and R = 0.005, LR = 0.0029, as in

Exercise 2.7b).

c) Consider next the proportional model. By definition,

mij = kpj for i �= j, and mii = 1− k(1− pi).

Show that

LR = k =
R

∑n
i=1 pi(1− pi)

.

and from this verify the answer of the previous exercise.



2.13. EXERCISES 75

Comment : Exact calculations for remaining mutation models are more tech-

nical. Section A.1.4 of the manual for Familias 3 http://familias.no/

contains some further examples.

Exercise 2.9 (Paternity case with mutation).

Load the file Exercise2_9.fam. Consider the hypotheses of Exercise 2.1.

a) Verify that the LR = 0.

b) There is one marker where the child and the alleged father do not share

an allele. Find this marker.

c) Use the Stepwise (Stationary) model, for females and males with mu-

tation rate 0.001 and mutation range 0.5 for all markers and calculate

LR.

d) Assume you are asked to consider the hypotheses H3: Brother of alleged

father is father. Calculate LR (H1/H3).

e) Is there a best mutation model? Should a mutation model be used rou-

tinely for all markers?

Exercise 2.10 (Sisters or half sisters?).

We would like to determine whether two girls (called sister 1 and sister 2 in

the left part of Figure 2.12) are sisters (corresponding to hypothesis H1) or

if they are half sisters (corresponding to hypothesis H2 shown on the right

hand side).

The genotypes are given in Table 2.9. with allele frequencies 0.1 for

systems S1 and S2, and 0.05 for systems S3–S5.
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Figure 2.12: Pedigrees (hypotheses) in Exercise 2.10.

Person S1 S2 S3 S4 S5

Mother A1/A2 A1/A2 A2/A3 A2/A3 A2/A3

Sister 1 A2/A3 A2/A3 A3/A4 A3/A4 A3/A4

Sister 2 A2/A3 A2/A3 A1/A3 A1/A3 A1/A3

Table 2.9: Marker data for Exercise 2.10

a) What is the LR comparing the full sister alternative to the half sister

alternative?

b) The LR in this case does not give rise to a clear conclusion. How would you

determine the required number of further markers needed for a reliable

conclusion? What markers would you use? You are not asked to do

specific calculations.

Exercise 2.11 (Silent allele).

a) See Figure 2.13. This is a paternity case where there is suspicion of a

silent allele. Include a silent allele frequency of pS = 0.05, and calculate
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the LR(father/not father) using Familias. The allele frequencies for A

and B are pA = pB = 0.1.

b) Confirm the above result using3

LR =
ps(pA + ps)

(pA + ps)
2(pB + 2ps) + pspA(pB + 2ps)

. (2.22)

Exercise 2.12 (*Theta correction, derivation of formula).

Verify theoretically the formula in Exercise 2.1h). Hint : Use the sampling

formula described in Section 2.5.1.

Exercise 2.13 (Theta correction, Familias).

This exercise expands on the previous Exercise 2.4 by introducing theta cor-

rection (kinship-parameter) of 0.02. Calculate the LR based on all markers.

To save time you can read input from the file Exercise2_4.fam.

Exercise 2.14 (Input and output).

A practical way to start work with Familias is to begin by reading a file

containing the relevant database. Sometimes it is, however, of interest to

read and write databases and case data and this will be the topic below.

a) Read input from the file Exercise2_3.

b) Export the data base from the General DNA data window. Name the

output file database.txt.

c) Export the case data from the Case DNA Data. Name the output file

casedata.txt.

3See http://dna-view.com/patform.htm
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d) Open a new project.

e) Import database.txt from the General DNA data window.

f) Import casedata.txt from the General DNA data window.

g) Define the pedigrees, see Exercise 2.3, and calculate the LR for all markers.

Exercise 2.15 (*Paternity case with dropout).

a) Load the file Exercise2_15.fam. Consider the hypotheses of Exercise 2.1.

Confirm that that LR = 0 and find the one marker where the child and

the alleged father do not share an allele.

b) Set the dropout probability to 0.1 for this marker, choose

Consider dropout in the Case DNA data window for the child and re-

calculate the LR.

c) The data could also be explained by a mutation. Compare the above

result with the LR you get with the mutation model (for this marker)

Stepwise (stationary) for females and males with mutation rate 0.001

and mutation range 0.5. Remove dropout. Comment : One could consider

both dropout and mutation.

d) Discuss: Should dropout be used for all homozygous markers?

Exercise 2.16 (Silent allele and dropout).

Consider the paternity case in Figure 2.13. We analyze two scenarios, first

that there is a silent allele passed on from the alleged father to the child,

and second that there is a dropout in both AF and the child. Let the allele

frequencies of A and B both be 0.2.
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AF
B/−

mother
A/−

child
A/−

Figure 2.13: Pedigree for Exercise 2.11 and 2.16.

a) Include a silent allele frequency of 0.05 and calculate the LR using Familias.

b) Remove the silent allele frequency and instead include a dropout proba-

bility of 0.05 for both the alleged father and child. Calculate LR.

Exercise 2.17 (Simulation).

Load the file Exercise2_17.fam. The hypotheses considered are as in Ex-

ercise 2.1. The file contains no genotype information. Use the simulation in

Familias to simulate genotypes for both individuals. Untick Random seed

and set seed to 12345. Use 1000 simulations and find

a) The mean LR(H1/H2) when H1 is true.

b) The mean LR(H1/H2) when H2 is true.

c) The probability of observing a LR larger than 50 when H1 is true.
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Exercise 2.18 (A fictitious paternity case). A child was conceived as a result

of a rape. The DNA-profiles of the defendant, mother, and child are available,

see Table 2.104 below. The Likelihood Ratio LR1,2 of this genetic evidence

for the hypotheses

H1 : The defendant is the father of the child,

H2 : The defendant is unrelated to the father of the child,

is very high, thus providing strong evidence for paternity of the defendant.

Now suppose that the defendant claims that he is innocent, but that he

believes his brother is the actual father of the child. We formulate a third

hypothesis

H3 : The defendant’s brother is the father of the child,

see Figure 2.14.

a) Give the algebraic formula for the Likelihood Ratio LR1,2 for loci CSF1PO,

D7S820, and D19S433.

b) Give the algebraic formula for the Likelihood Ratio LR3,2 for the same

loci.

c) Can you compute LR3,2 numerically with the information above, or do

you need a table of allele frequencies? Can you explain why?

d) What is the Likelihood Ratio for H1 versus H3 based on these three loci?

4Thanks to Klaas Slooten for this exercise. This is fictitious case. Similar cases are

sometimes encountered in practice.
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e) In the algebraic formula for LR1,3 for locus CSF1PO, calculate its limits

for p15 → 1 and p15 → 0, and explain the outcome.

f) Do the same for LR1,3 on locus D19S433 when p14 → 1 and p14 → 0.

g) Discuss in the same way locus D7S820.

h) It can be shown that LR3,2 = 500. Can you calculate the probability that

each hypothesis is true?
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Locus Mother Child Defendant LR1,2

1 CSF1PO 10/14 10/15 14/15 4.56

2 D2S1338 17/17 17/24 17/24 4.26

3 D3S1358 14/16 14/17 17/18 2.36

4 D5S818 11/13 12/13 11/12 2.83

5 D7S820 11/12 11/12 11/12 2.92

6 D8S1179 10/14 10/15 14/15 4.56

7 D13S317 8/13 12/13 12/12 3.24

8 D16S539 9/10 9/9 9/12 4.81

9 D18S51 13/14 14/18 13/18 5.45

10 D19S433 14/14 14/14 14/14 2.93

11 D21S11 29/29 29/30 30/33.2 2.15

12 FGA 22/24 24/24 22/24 3.63

13 TH01 9.3/9.3 9.3/9.3 7/9.3 1.64

14 TPOX 8/8 8/8 8/8 1.84

15 vWA 15/18 15/16 16/16 4.96

16 All 50218439.00

Table 2.10: Data for Exercise 2.18.
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GF
−/−
−/−
−/−

GM
−/−
−/−
−/−

Brother
−/−
−/−
−/−

 Defendant
14/15
11/12
14/14

Mother
10/14
11/12
14/14

Child
10/15
11/12
14/14

My brother did it! CSF1PO, D7S820, D19S433

Figure 2.14: Hypothesis 2 in Exercise 2.18 with genotypes for CSF1PO,

D7S820, D19S433.
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3.5 Exercises

Solutions and input files can be found at http://familias.name.

Exercise 3.1 (DVI - A warm up example). We consider a small DVI case 

with necessary data given in Figure 1.3 (also available as http://

familias.name/Fig_3_2.PNG). There are three victims, called V1, V2 and 

V3. Reference data have been obtained from two families, F1 and F2. 

There is one marker (M1) with equifrequent alleles 1, 2, 3 and 4. (We 

assume mutation rates equal to zero.) In the DVI module of Familias, the  

reference families are treated one-by-one sequentially. The hypotheses for 

family F1 are:

• H1: V1 belongs to F1.

• H2: V2 belongs to F1.

• H3: V3 belongs to F1.

• H4: Some unknown person, NN, belongs to F1.

In other words, we consider four different possible hypotheses for the first

family (F1). We start with some theoretical calculations before confirming

the manual derivations in Familias.

a) Find the likelihood ratios LRi = Li/L4.

b) We assume a flat prior, i.e., Pr(Hi) = 0.25. Calculate the posterior prob-

abilities Pr(Hi | data).

c) The hypotheses for family F2 are:

theg
Sticky Note
The AM option in DVI is default, the only available when the book was published.
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H1 : V1 belongs to F2.

H2 : V2 belongs to F2.

H3 : V3 belongs to F2.

H4 : Some unknown person, V4, belongs to F2.

d) Repeat a) and b) for the above hypotheses.

e) Confirm the manual calculations in Familias. First, define the frequency

database according to the specifications above.

f) Open the DVI interface.

Hint : Tools -> DVI module -> Add Unidentified Persons. A dd per-

sons and corresponding genotypes as specified for V1, V2 and V3 in Fig-

ure 1.3.

g) Continue by specifying the reference families Hint : Next and then Add. 

The families are specified by first specifying the persons, i.e., for F1 we 

define the typed father and mother while for F2 we define the typed father. 

Add the genotypes as specified in Figure 1.3. Next add the pedigree 

specifying the necessary relationships between the typed persons and the 

missing person. Hint: Add in the Pedigrees section. Never mind the 

pedigree named Reference pedigree for now, we will return to the 

importance of this later.

h) Perform a search using a Threshold/Limit of 0. Hint : Next and then

Search.

i) Confirm the manual calculations above.
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Exercise 3.2 (Blind search - A warm up example). The blind search inter-

face is, as the name suggests, a tool to blindly search for predefined pairwise

relationships in a data set. The interface currently allows the user to search

for Parent-Child, Siblings, Half-siblings, Cousins, Second cousins as well as

Direct matches. For the direct matching, Familias implements a special

algorithm, which will be explored in more detail later. A blind search may

be performed in connection with the DVI module, e.g. to search a set of

unidentified remains for direct matches or relationships within the data set.

Another application may be to investigate a data set for unspecified relations

before conducting a medical study or prior to creating a frequency database.

The computations are swift and may be used to search large data set for

relations. We will first test the module on a smaller data set.

a) Create one allele system with four alleles, 12, 13, 14 and 15 and allele

frequencies uniformly distributed as 0.25.

b) Define four males P1, P2, P3 and P4. Enter DNA data as P1=12/12;

P2=12/12; P3=13/14; P4=14/15. Hint : You should define individuals in

Tools->Persons.

c) Enter the Blind search dialog Hint : Tools->Blind search.

d) Press New search and select Direct-match and Siblings as relation-

ships. Hint : Hold down Ctrl to select multiple items in the list. Leave

the Match threshold and θ at their default values. Set the remaining

parameters (Typing error, Dropout prob. and Dropin) to 0.

e) Interpret the results.



3.5. EXERCISES 125

f) Confirm the LR-values by manual calculations.

g) Try different values for Typing error, Dropout prob and Dropin. Specif-

ically, change only one value to 0.1, i.e., leaving the other two at 0. Com-

pare results to what you expect (exact calculations are not expected here).
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Exercise 3.3 (DVI - An extended example).

Consider the crash of a small plane with 10 passengers. We have obtained
reference data from 5 different families. There are many steps and the exer-
cise may take some time, but we encourage users to push through all steps
as there is a lot to learn by doing this.

a) In Familias, open the Exercise3 3.fam file, which contains frequency
data for 23 autosomal markers.

b) Enter the first step in the DVI module, Add unidentified persons. We
may define individuals manually, similar to normal Familias procedure,
though we prefer importing data from file to skip as much manual input
as possible. Import the file Exercise3 3 pm.txt. Note: Familias can
import different files formats, e.g. CODIS xml and tab-separated text
files.

c) The file only contains 8 unidentified remains. Discuss why this may be a
realistic scenario, especially in larger scale scenarios. How may this effect
the calculations?

d) Deselect Use list and enter 10 in the Size box. This is used to define
the priors. We will not dwell on the discussion of priors for now. Briefly
we define the number of missing persons to 10.

e) Press Next to define reference families. We may now either define families
manually or we may import them from file. We will here consider two
different alternatives. Define the first family manually by selecting Add.
Enter a name for the family, Family 1.
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f) Import data for the persons in the family (a father). Import the file
Exercise3 3 am1.txt. (Note: it is not necessary to first manually define
the typed persons.)

If relevant, now is the time to define other persons included in the family,
in the current family none. Note, this may be untyped persons necessary
to define the relations between the reference persons and the missing
person(s). We will return to an example of this later.

g) We continue with defining the relation between the defined person(s) and
the missing person. (Note: simply naming the person father/mother/brother
etc. does not define the relationships). Select Add in the pedigree section
to add a new pedigree. Name the pedigree appropriately, Father, and add
necessary relation between the reference person(s) and the missing per-
son. Press Close and then Close again to return to the list of reference
families.

h) Define also a second family, where data is available for a brother of a
missing person, by pressing Add. Enter a name, Family 2.

i) Import reference persons from file Exercise3 3 am2.txt

j) Add necessary additional persons, untyped mother and father, and then
define the reference person as brother to the missing person. Hint : Add
a pedigree as for Family 1 and specify that the brother and the missing
persons share the same parents.

k) Add the rest of the reference families by selecting the import option
Simple and select files Exercise3 3 am3.txt, Exercise3 3 am4.txt,
and
Exercise3 3 am5.txt. Change the names of the families to Family 3,
Family 4 and Family 5. Also, check the persons and pedigrees in each
imported family to make sure you know the relationships. Rename the
pedigrees to reflect the defined relationships.

l) Press Next and Search to start the matching. Select the threshold for a
match to be reported. Enter 1.0, as we would rather obtain more matches
at this stage and later remove matches which may be spurious.

m) Interpret the results. Were all remains identified?
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n) Select a match and press View match to investigate the individual LRs
for each system.

o) We suspect there might be relatives among the unidentified persons. Enter
the first step, Add unidentified persons and select Blind search. Use
your knowledge from Exercise 3.2 to perform a blind search for siblings
relations. (Use 10 as match threshold, leave all other options at default)
How may the results be used in the DVI operation?

p) Change the size of the accident in step c) to 100 and see how this affects
the priors in the current case. How does this in turn affect the posteriors?
Hint : Perform a new search to see the effect.

q) * New information is added to the case. The first family, defined manually
in d) also contains a second missing person. The brother of the reference
father is also missing. Try finding out how this could be solved using the
means available in the DVI module.

r) * Perform a new search, use LR threshold 1 and size of accident 10.

s) * Discuss the solution and other ways to improve the algorithm.

t) Save the project.

Exercise 3.4 (DVI - Quick searching).

Generally, pedigree structures may be complex and thus calculations with a
large number of unidentified individuals will be computer intensive. Familias
implements functionality to speed up calculation in the DVI interface. This
exercise will illustrate the features and how they are used.

a) Open the file Exercise3 4.fam, which contains the final project from
the previous exercise. Skip to the Search dialog in the DVI interface and
press Quick scan. This will open a version of the Blind search dialog.
Select Parent-Child and Siblings and match limit 10. Hit Search.

b) Compare the current results to the results obtained in the previous exer-
cise.

c) What are the obvious benefits of using the Quick scan function?
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d) In addition to the Quick scan function, Familias implements an algo-
rithm to quickly compare reference families with PM samples using a zero
mutation rate model. Enter the advanced settings, File->Advanced and
select/deselect Quick search to activate/deactivate this feature.

e) Make sure the Quick search is selected and enter 1 as number of al-
lowed mismatches. Return to the Search dialog in the DVI interface and
perform a search with a match threshold of 0.0001.

f) Save the results using the Export list function.

g) Return to the advanced settings and change the number of allow mis-
matches to 2.

h) Perform a new search and compare the results to the ones obtained in f).

i) In light of the results, discuss “good” values on the number of mismatches
and the benefits of using the quick search features.

Exercise 3.5 (DVI - A simulated example).

This exercise is divided into two different parts,

1. Simulate data in Familias and prepare it for input to the DVI module.
(Requires Excel or similar software)

2. Using the DVI module on the simulated data.

The exercise deals with a larger dataset of simulated pairs of sisters using real
frequency data for 23 autosomal STR markers. As described, the first part of
the exercise deals with how to simulate relationships in Familias and use the
genotype data from the simulations. Skip to h) for DVI exercises only. Parts
b) through g) are particularly useful for readers interested in simulating data
for validation purposes and to understand some of the import formatting
recognized by Familias.

a) Open the database from the file Exercise3 5.fam, containing frequency
data for 23 autosomal STR markers. Briefly explore the database before
continuing to make sure you are familliar with the markers and parame-
ters.
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b) Enter the Advanced dialog (Hint : File->Advanced) and make sure
Save genotype data is selected and Save complete data is deselected.
Press Save.

c) Define the persons necessary to simulate a pair of full siblings, i.e., Mother,
Father, Sister1 and [Sister]. Note, it is important that you name the sec-
ond sibling as indicated, i.e., [Sister]. In later steps Familias will recog-
nize this as a relationship indicator and construct pedigrees automatically.

d) In the Pedigree dialog, create two pedigrees, the first specifying Sister1
and [Sister] as full siblings. The second one without any relations.

e) Press Simulate. Specify that we will have genotype data for Sister1 and
[Sister]. Enter 100 simulations and set the seed to 12345. Also, select to
save the raw data.

f) Press Simulate and save the genotype data to a text file. (Leave Familias
open)

g) The following steps prepare the output for import into the DVI module
of Familias:

1. Open the simulated genotype data in Excel, or similar software. (If
the alleles appears as dates, please consult http://familias.name.)

2. Save the file as a new file using the xls or xlsx format for better com-
patibility.

3. Select the first row and select Filter. Hint : Usually found in the Data
tab.

4. In the first column (True ped) select to only view Ped 1 (or the name
you gave to the full siblings pedigree) and in the second column select
to only view Sister1.

5. Now, copy all the filtered data into a new file. Hint : Ctrl+a followed
by Ctrl+c followed by Ctrl+n followed by Ctrl+v. Remove the first
column, i.e., information about the pedigree.

6. In the first column select the first occurrence of Sister1. Fill down,
such that the numbering is Sister1, Sister2,...,Sister100.

http://familias.name
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7. Save the new formatted file as Exercise3 5 pm.txt and make sure
the format is tab-separated text file. (This file now contains data for
100 unrelated individuals serving as the PM data later)

8. Return to the original Excel document and remove the filtering. In
the first column select again to only view Ped 1 and in the second
column select to only view [Sister]. Using the same procedure as in
5., copy the filtered data to a new document. In the first column in the
second row, rename from Ped 1 to Family1. Fill down such that the
numbering becomes sequential, i.e., Family1, Family2,...,Family100.

9. Save as Exercise3 5 am.txt. This file now contains data for 100
reference sisters serving as the AM data later

h) Open the DVI interface and import the fileExercise3 5 pm.txt contain-
ing the data for 100 unrelated individuals serving as the set of unidentified
remains. Hint : if you didn’t perform the simulation steps, see a) before
continuing.

i) Run a blind search and search for siblings using a match threshold of 10.
(Leave all other parameters at their default values.)

j) Comment on the results

k) Continue to specify reference families. We will use the Data only im-
port option, allowing a simple import. Select and import file Exer-
cise3 5 am.txt. This will import 100 reference families with a brother
as reference person. Explore the families and see how the import has
automatically detected the relationships.

l) Perform a search using a match threshold of 10. Comment on false pos-
itives/negatives and investigate spurious matches using the View match

button. For comparison, SisterX goes with Family X, where X is an inte-
ger 1-100.

Exercise 3.6 (Familial searching - Warm up example). This exercise intro-
duces the Familial searching module in a simple case. First some calculations
are done by hand which are later checked using Familias. Consider a marker
L1 with alleles 12, 13, 14 and 15, all with frequency 0.25, and a database of
convicted offenders consisting of four individuals with genotypes P1=12/12,
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P2=12/13, P3=13/14, and P4=14/15. For simplicity, we disregard compli-
cating factors like mutation, theta-correction, dropin, dropout and typing
error.

a) There is a stain S1=12/13, assumed to be from one individual. Consider

Hi: S1 = Pi

H0: S1 is unrelated to Pi.

and calculate LRi = Pr(data | Hi)/Pr(data | H0). (Answer: LR2 =
1/(2× 0.25× 0.25) = 8 and LRi = 0 for i 6= 2.

b) Repeat above calculations when Hi : S1 is child of Pi. (Answer: LR1 =
2, LR2 = 2, LR3 = 1, LR4 = 0.)

c) There is a stain S2 = 12/13/14/15 assumed to be from two contributors.
Consider

Hi: Stain comes from Pi and an unrelated individual not in the database.

H0: The stain comes from two unrelated individuals not in the database.

Calculate LRi = Pr(data | Hi)/Pr(data | H0). (Answer: We first find the
likelihoods

Pr(data | H0) = 24× p12p13p14p15 =
3

32
Pr(data | H1) = 0,

Pr(data | Hi) =
1

8
, i = 2, 3, 4.

Therefore LR1 = 0, LR2 = LR3 = LR4 = 4
3
.

d) Consider

Hi: Stain comes from son of P1 and an unrelated individual (NN) not in
the database.

H0: The stain comes from two unrelated individuals not in the database.
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Calculate LR1 = Pr(data | H1)/Pr(data | H0). Answer: The son must
be 12/13, 12/14 or 12/15 and so

Pr(data | H1) = Pr(son = 12/13, NN = 14/15 | father = 12/12)

+ Pr(son = 12/14, NN = 13/15 | father = 12/12)

+ Pr(son = 12/15, NN = 13/14 | father = 12/12)

= 6p13p14p15.

Therefore LR1 = 1
4p12

= 1.

e) Consider the above problem with P2=12/13 replacing P1 and calculate
LR2 = Pr(data | H2)/Pr(data | H0). Answer: The son must be 12/13,
12/14, 12/15, 13/14 or 13/15 and so

Pr(data | H2) =
1

2
(p12 + p13)2p14p15

+ 2p13p14p15 + 2p12p14p15

= 3p12p14p15 + 3p13p14p15

Therefore LR2 = p12+p13
8p12p13

= 1.

f) Next, the above calculations are confirmed using Familias.

1. Start Familias and define the marker L1.

2. Enter Tools->Familial searching: Enter name P1 and Add. Add
genotype data by selecting system L1. The manual input deviates
from other parts of the program to allow for mixtures. Select Allele

1 and 12. Select Allele 2 and 12. Press Add to add the observations.

3. Define P2, P3 and P4 similarly.

4. Enter Next and define the stain S1.

5. Enter 0 for all search options, i.e., LR threshold and the other pa-
rameters should be set to 0.

6. Select Parent-child and Direct match in the upper right corner.

7. Enter Next and press Search. Confirm the answers in a) and b).

8. Return to the previous dialog, where we defined the stain. Import a
mixture from the file Exercise3 6.xml. The sample is the previous
mixture of two contributors: 12/13/14/15.
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9. Confirm the previous calculations.

Exercise 3.7 (Looking for the relative of a stain). The following exercise
will explore the Familial searching module more thoroughly.

a) Start by importing the frequency database from the file
Exercise3 7.fam and explore the contents.

b) The database containing convicted offenders and traces from previous
crimes is contained in the file Exercise3 7db.txt. Import the file into
the familial searching interface.
Hint : Tools->Familial searching. In total there should be 1000 ele-
ments, genotyped for different sets of markers. The latter may be common
as different marker kits may have been used throughout the history of the
database.

c) Perform a blind search on the database searching, using the option Direct
match. Use default parameters values. Be patient, the search may take a
while. How many comparisons are performed?

d) Comment on the results and whether the values on the dropout, dropin
and typing error parameters (default values) are appropriate.

e) Can a blind search be performed on a database of say 5,000,000 elements?
Compute the number of comparisons necessary for such an operation.

f) Press Next and continue with importing a batch of traces from some crime
scenes. Import data from the file Exercise3 7tr.txt.

g) Specify that you wish to search for Direct match first. Let Dropin=0.01,
Dropout=0.05 and Typing error=0.001. Set the match threshold to 1.

h) Perform a search and comment on the results.

i) Return to the previous dialog to specify a new search. Now select the
Parent-Child and Sibling relations. Set the match threshold to 10 and
leave the other settings at their default values.

j) Perform a new search and sort the matches using the Sort button. Select
a subset of the matches to explore further. Use the Subset button and
select the top-k method. Enter 10 as the number of matches to select.
Review the results.
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k) Press Search to redo the search. Select the LR threshold method in the
subset feature. Enter 100 and apply. Review the results.

l) What are the benefits and downsides of using the top-k method compared
to the LR threshold method?

m) Familias furthermore implements another subsetting method, Profile
centered. The algorithm will perform conditional simulations based on
the candidate (matching) profile and find a (LR) threshold based on the
results. Perform the search again and apply the Profile centered method
with the alpha parameters set to 0.9. Review the results and compare
them to the ones obtained using the other two subset methods.

n) * Try explaining the benefits of using the Profile centered method and the
meaning of the alpha parameter. Without changing the parameter, what
will happen for low values on alpha? Confirm your answer in Familias.

o) Now, return to the search options and specify that you wish to scale
against Cousins. In addition, specify the value of Fst to 0.02. When may
these specifications be relevant? (Leave the other parameters at their
default values).

p) Perform a search using the new settings and comment on the results.
Compare with the results obtained in j).
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4.5 Exercises

Solutions and input files can be found at http://familias.name.

4.5.1 Autosomal markers and FamLink

Familias, used in previous chapters, does not consider linkage, instead we

introduce FamLink for pairs of linked autosomal markers. Some basic func-

tionality will be explored as well as more advanced functions and theoretical

points.

Note that genders in the predefined figures may deviate from the ones in

the exercise. This can however be overwritten in a subsequent step.

Exercise 4.1 (Simple paternity case. Video).

We will first consider a simple exercise where the purpose is to get familiar

with the user interface and create your frequency database. Normally a

saved frequency database will be loaded. Consider a paternity case (Duo)

(for illustration see Figure 2.2) with hypotheses,

H1: The alleged father (AF) is the real father.

H2: The alleged father and the child are unrelated.

a) Specify two allele systems, L1 and L2 with alleles 12, 13 and 14 for both

systems.

Hint : File->Frequency database. Let p12 = 0.1, p13 = 0.2 and p14 =

0.7 for both systems. The loci are closely linked, specify the recombination

rate (θ) to 0.01. Hint : File->Frequency database->Options.
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b) In several situations we only have the genetic distance between markers,

measured in centiMorgans (cM). How can we convert between genetic

distance and recombination rate?

c) Select the appropriate pedigrees using File->New wizard and specify

the data for the father as homozygous 12/12 for both loci and the child

heterozygous 12/13 for both loci. Calculate the LR which should coincide

with the theoretical value of 25. Also compute the posterior probability

using equal priors Hint : press the LR/Posterior button to change the

displayed results.

d) Try changing the recombination rate to 0.5 and calculate the LR again.

What happens? Explain why!

e) * Use pen and paper to show that LR=25. Use the same notation as in

Equation 4.3, page 151.

f) The alleged father states that it could be his brother who is the true fa-

ther of the child. Change H2 to uncle by returning to the

Select alternative hypothesis window. Calculate the LR with re-

combination rate specified to 0.01.

g) Save the FamLink file (we suggest the file extension sav). Exit FamLink.

Exercise 4.2 (A case of disputed sibship).

The exercise involves two persons P1 and P2 interested to find out whether

they share the same mother and/or father. We consider multiple hypotheses,

H1: P1 and P2 are full siblings,
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H2: P1 and P2 are half siblings,

H3: P1 and P2 are unrelated.

a) Reuse the frequency database specified in the previous exercise. Hint :

File->Open->Project. Select the appropriate pedigrees, corresponding

to the hypotheses above, and specify the data for P1 as homozygous

12/12 for both loci and P2 as homozygous 12/12 for both loci. Hint :

Select multiple alternative hypotheses by holding Ctrl while selecting.

b) Calculate the LR. Scale versus the Unrelated pedigree and discuss the

LR:s for full siblings and half siblings. Compute also the posterior prob-

abilities using flat priors.

c) * Compute by hand the LR comparingH1 versusH2 from previous output.

d) Try changing the recombination rate to 0.5 and calculate the LR again.

What happens? Explain why!

e) * Can linked autosomal markers be used to distinguish maternal from

paternal half siblings?

Exercise 4.3 (Immigration case).

In cases of immigration, several alternative hypotheses may be relevant and

linked markers may prove useful in the determination of the most probable

one. In the current exercise we will explore a case where autosomal markers

are unable to distinguish between the alternatives. Consider marker data

for two markers vWA and D12S391, with frequency data as indicated in

Table 4.13. We furthermore specify hypotheses,
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Alleles vWA (freqs) D12S391 (freqs)

14 0.30

15 0.10

16 0.05

17 0.20 0.20

18 0.25 0.10

19 0.30

20 0.20

21 0.20

Table 4.13: Allele frequencies for Exercise 4.3.

H1: P1 is the uncle of P2.

H2: P1 is the grandfather of P2.

H3: P1 and P2 are unrelated.

a) Specify the recombination rate to 0.1. Specify the genotypes for P1 to

15/15 and 20/20 for vWA and D12S391 respectively, while for P2 has

identical genotypes as P1, for both loci. Calculate the LR and scale

versus Unrelated. Discuss the results

b) Without changing the recombination rate to 0.5, discuss what will happen

if you were to do this.

c) Change the recombination rate to 0.5 and compare to your result in b).

d) Calculate the LR also for r = 0.25 and compare the results from a), b)

and c)
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e) Save the project using the .sav file extension.

Exercise 4.4 (It was my brother who did it!).

FamLink may be used in criminal cases where the defendant claims: “It was

my brother who did it!”. Suppose we have some stain, assumed to be from

one person, from a crime scene where we wish to provide some probability

as to whether a suspect could be the source of the stain. The random match

probability is low, suggesting that the defendant may be the source of the

stain. The defendant claims he is innocent and suggests that a brother of

him did it. We consider hypotheses,

HD1 : The brother of the defendant is the source of profile in the stain.

HD2 : A random man, unrelated to the defendant, is the source of the profile

in the stain.

HP : The defendant is the source of the profile in the stain.

a) Open the saved project from Exercise 4.3, containing the frequency database.

Specify the recombination rate to 0.09.

b) Select the pedigree Full siblings (corresponding to HD1) as the main

hypothesis and select Unrelated as the alternative hypothesis, HD2.

c) For the two individuals enter the same data for both individuals, 14/14

for vWA and 21/21 for D12S931.

d) Calculate the LR. Discuss the result.

e) * Compute the likelihood for HP and HD2 by hand. Calculate also the

LR comparing HP versus HD2
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f) * Calculate the remaining LR:s comparing HP with HD1. Hint : Use the

LR calculated by hand with the one obtained in e).

g) Export the multiplication factor and discuss its meaning. Hint : Use

Save results.

h) Given the results in e), the defendant is interested if some other relative

could be blamed. As a scientist you are curious to find out and try

“Uncle” and “Grandfather” as alternative hypotheses. Calculate the LR

and discuss the results.

Exercise 4.5 (On the impact of linkage).

The purpose of this exercise is to illustrate how FamLink can be used to study

the general impact of accounting or not accounting of linkage for an incest

case, see Exercise 2.6, page 70. To study the impact on a specific case we may

use simulations, a resourceful tool included in the software. Simulations are

performed assuming each of the specified hypotheses to be true and calculate

the LR for each case. A summary statistic is then reported.

We specify the hypotheses as

H1: The father of the mother is also the alleged father (AF) of the child.

H2: Another man, unrelated to the alleged father is the father of the child.

The alleged father is still the father of the mother.

a) We use real frequency data from the STR markers vWA and D12S391.

Import the file Exercise4 5.txt, containing the frequency database for

the two STR markers. Hint : File->Frequency database and Import.
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b) Set the recombination rate to 0.089. (This corresponds to estimates in

the literature). Select appropriate pedigrees but do not enter DNA data.

c) Perform simulations using a seed value of 12345. Hint : Instead of Calculate,

hit Simulate. Do 1000 simulations which is generally a reasonable number

to obtain an idea of the distribution of the LR. Select to Save raw data

and place the file somewhere you can find it.

d) Once we have performed simulations we may store a summary. Save a

simulation report and explore the contents:

Save results and Simulation report.

e) What is the median effect of linkage on the LR in the current case given

H1 is true?

f) * Open the raw data txt-file in Excel (or similar software), and estimate

the average, given H1 is true, from the ratio

LR(Not accounting for linkage)/LR(Accounting for linkage).

g) * The LR assuming H2 is true will often be zero in the current case. Ex-

plain why. Note that zeros will be disregarded when calculating summary

statistics.

h) ** The expected LR under H2 is 1 as shown in (8.3). Is this true in the

current case? What can be done to improve the fit to the expectation?

Exercise 4.6 (A real example).
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Another pair of closely located markers is SE33 and D6S1043 with a genetic

distance of only 4.4 cM. The markers are both included in some commercial

STR multiplexes. We are interested to find the multiplication factor for the

hypotheses

H1 : Two females, Sister1 and Sister2, are full siblings. (Data available for

the common mother.)

H2 : Maternal half siblings. (Data available for the common mother.)

a) Compute the recombination rate in FamLink using Haldanes mapping

function. Hint : Tools->Conversion)

b) We use real allele frequency data from a Chinese Han population. Import

the file Exercise4 6.txt, containing the frequency database for the two

STR markers. Specify the recombination rate calculated in a).

c) Specify the data for Sister1 as 14/14 for D6S1043 and 21/23.2 for SE33,

for Sister2 as 14/14 for D6S1043 and 21/24 for SE33. Furthermore, specify

the data for the mother as 14/19.3 and 17/21.

d) Calculate the LR in FamLink and compute the multiplication factor by

hand using the results.

e) The multiplication factor may be combined with the total LR obtained

in some other software, where linkage is not accounted for. Discuss how

this is possible.

f) * Perform 1000 simulations (using seed=12345). Find the distribution for

the multiplication factor in the simulation report for each simulated hy-
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pothesis. What are the values for the 5 and 95 percentiles? Hint : Use the

fact that the multiplication factor is equal to LR(no linkage)/LR(linkage).

Exercise 4.7 (* Defining pedigrees).

FamLink includes a number of predefined pedigrees where the user only needs

to select the required pictures indicating the family structure. We may also

create our own pedigrees using the Merlin Input file notation

(see http://www.sph.umich.edu/csg/abecasis/merlin/tour/input_files.

html). Consider a case of three persons interested to know whether they are

all full siblings or unrelated:

H1: Three persons (P1, P2 and P3) are full siblings.

H2: P1, P2 and P3 are unrelated.

a) We will use the same frequency database as in Exercise 4.2, but specify

the recombination rate to 0.1.

b) Specify the needed relationships in a text file and rename it to Exer-

cise4 7.ped. Specify the data for all persons to 12/12 at the first locus

in the same file. For the second locus we will add a previously unseen

allele, denoted 11; specify the data for all persons as 11/12.

c) Import the pedigree into FamLink.

(This is done by File>New wizard>Import ped file). When the new

allele is imported we require a frequency. Specify 0.05 for allele 11 and se-

lect “Search and subtract” as method. (See manual at http://famlink.

se for details on the “Search and subtract” method)
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d) ** Discuss the Search and subtract method in the current context.

Would it be applicable in e.g. Familias?

e) Calculate the LR and discuss the results.

f) Discuss the hypotheses and whether you would consider alternatives.

Exercise 4.8 (A case of identification).

The following serves to illustrate the importance of linkage in a real case.

Identification of unidentified remains is a recurring task at forensic labora-

tories. A skeleton was found and successfully genotyped for two overlapping

commercial STR kits, yielding in total data for 23 autosomal STR markers.

A putative sister of a missing person (MP) was genotyped for the same 23

markers. The hypotheses are defined as

H1 : The sister is the true sister of MP.

H2 : The sister is unrelated to MP.

The combined results gave LR = 500 in favor of H1. We will use FamLink

to examine the results for the markers vWA and D12S391 and how the linkage

between the two markers influence the results.

a) Open the file Exercise4 8.sav in FamLink. The file contains a real fre-

quency database for the indicated STR markers from a Norwegian popu-

lation sample. Specify the recombination rate to 0.089.

b) Select the hypotheses indicated above and enter the data for the remains

as 14/14 for vWA and 21/21 for D12S391. Similarly for the sister enter

14/14 for vWA and 21/21 for D12S391.
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c) Calculate the LR and discuss the results. Would accounting for linkage

change you conclusion?

d) Try changing the genotype data for the persons to see how this affects

the outcome.

e) * In light of the results, try to discuss when we can expect an increase/decrease

in the LR when accounting for linkage in the current case.

Exercise 4.9 (* Theoretical exercise).

The following exercise is meant for mathematically oriented readers. We will

consider the well discussed example of uncle versus half siblings, mentioned

in the text. Consider two STR markers L1 and L2, where the genetic distance

and hence the recombination is unspecified but can be denoted with ρ. We

further consider hypotheses according to,

H1 P1 and P2 are related as half siblings

H2 Two persons, P1 and P2, are related as uncle/nephew.

a) * The genotype data is indicated in Table 4.14. Use your knowledge

about IBD patterns to derive a theoretical formula for the LR for the

two markers L1 and L2. Hint : Use methods described in Example 4.2 on

page 152.

b) * Confirm your formula with FamLink, using p12=0.1, p21=0.05 and r =

0.1. Hint : The frequencies of the other alleles are irrelevant, use any

value.
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P1 P2

L1 9/12 12/15

L2 19/21 21/25

Table 4.14: Genotype data for Exercise 4.10 .

c) * Plot the LR as a function of the recombination rate using the same

allele frequencies as in b).

Exercise 4.10 (Extended example).

In addition to creating our own pedigrees we may also analyze previous

Familias projects (v 1.81 or above), to obtain an LR where linkage between

virtually any number of markers are considered. All commonly used STR

markers as well as a number of less common markers are predefined with their

genetic distances specified, see file markerInfo.ini provided in the FamLink

install directory. As indicated we may now consider more markers and more

complicated pedigree structures. The following is extracted from a real case,

see Figure 4.19, consider

H1: The Alleged Father is the true father of the Child (see Figure 4.19).

H2: The Alternative father is instead the father of the Child.

a) Open the file Exercise4 10.fam in Familias and explore the project.

(Note: the person marked as Cousin in Figure 4.19 is not included since

Familias versions below 3.0 could not handle the complexity of the
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Figure 4.19: Complex kinship case.

project). The project contains genetic marker data for 35 autosomal STR

markers.

b) Calculate the LR in Familias, be patient, the computations may take

> 20 minutes depending on the performance of your computer. You may

also choose to skip this.

c) Open the Quick analysis interface in FamLink. Mark generate report

and browse to the file Exercise4 10.fam.

Hint : Tools->Quick analysis.
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d) Perform an analysis of the Familias project by pressing analyze.

e) Open the generated report (found in the same directory as the exercise

file) and browse the contents. Find the LR and compare it to the one

obtained in Familias.

f) The analysis includes markers from the commercial kits HDplex (QIA-

GEN), PP16 (Promega) and ESX17 (Promega). What can be said about

the number of linked markers on different chromosomes combining all the

kits? Hint : See FamLink report)

g) Try using the function on your own Familias projects!

Exercise 4.11 (** Combining linkage and subpopulation effects).

This exercise is interesting for the more mathematical oriented users. To

allow for subpopulation structures we may adjust the allele frequencies using

θ correction, see Section 2.5. We may actually combine the effect of linkage

with correction for subpopulation structure in a model quite easily. Consider

the hypotheses

H1 Two persons, P1 and P2, are related as Half siblings.

H2 P1 and P2 are Unrelated.

a) * P1 and P2 have genotype data as indicated in Table 4.14. Using the

sampling formula, see p. 42, derive the theoretical expression for the LR.

Hint : You may reuse formulas derived in Exercise 4.9)

b) * Using that p12 = 0.2, p21 = 0.1 and r = 0.01, compute the LR.
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c) ** Using the sampling formula provided in chapter 2 and that θ = 0.02,

compute the updated set of allele frequencies. Hint : Given zero alleles

are IBD we have four different observations, whereas given one allele IBD

we have three different observations)

d) ** Compute the LR using that θ = 0.02. Hint : Use the results in b) and

c))

e) ** Plot the LR versus the value of θ using the specifications in b).

4.5.2 X-chromosomal markers and FamLinkX

FamLinkX implements an algorithm for linked markers on the X-chromosome.

In addition to linkage the software accounts for linkage disequilibrium (allelic

association) and mutations. The software is intended to be user-friendly but

may provide obstacles for the inexperienced user. FamLinkX provides the

likelihood ratios using three different methods, M1: Exact model, consider-

ing linkage, linkage disequilibrium and mutations; M2: Cluster approach, see

manual for Merlin, linkage and linkage disequilibrium is considered but not

recombinations within clusters and not mutations; M3: Only linkage is con-

sidered between markers. In the following exercises we are interested in M1

as this is the preferred model, specially for STR markers, but comparisons

to the other models will be made. For all calculations, unless stated other-

wise, we consider X-chromosomal marker data and corresponding inheritance

patterns.

Exercise 4.12 (A paternity case revisited. Video).
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12 13

16 59 1

17 1 39

Table 4.15: Haplotype observations for Exercise 4.12 .

We will first revisit the paternity case (Duo) (for illustration see Figure 2.6)

with hypotheses

H1: The alleged father (AF) is the true father of the female child.

H2: The alleged father and the child are unrelated.

a) Open FamLinkX and specify the frequency database. Hint :

File->Frequency database. Create a new cluster and specify two dial-

lelic systems, L1 and L2, with alleles 12, 13 and 16, 17 respectively. Let

p12 = 0.6, p13 = 0.4 for L1 and p16 = 0.6, p17 = 0.4 for L2. Select the

Simple mutation model with the mutation rate set to 0 for both systems.

Set the genetic position to 10 cM for L1 and 10.1 cM for L2. Furthermore,

specify haplotype observations according to Table 4.15. Why is it impor-

tant that we explicitly specify the gender of all persons in calculations for

X-chromosomal marker data?

b) What is the estimated recombination rate between the two loci? Use

Haldane’s mapping function.

c) Why do we specify the number of observations for each haplotype?
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d) Use the equation below to calculate a measure of the association between

the alleles

r2 =
(p12p16 − p12,16)

2

p12p13p16p17
. (4.12)

e) Specify λ to 0.0001 in Options. We will discuss the importance of λ in

Exercise 4.14 and will not dwell further on it now. In brief, setting a

low λ gives large weight to the observed haplotypes in Table 4.15. Select

the appropriate pedigrees using the Wizard. The alternative hypothesis

depicts two unrelated girls, but the first hypothesis will override the gen-

ders. Hint : File->New wizard and specify the data for the father as 12

for L1 and 17 for L2 and the child as 12/12 for L1 and 17/17 for L2.

Calculate the LR which should coincide (approximately) with the theo-

retical value of 100. Choose to save the file when asked. There may be

a small deviation from the theoretical value, which we will return to in

later exercises.

f) Change the genotypes for the child to 12/13 for L1 and 16/17 for L2.

Calculate the LR.

g) Change the number of observations for each haplotype. What happens?

Explain why!

h) * Discuss the high degree of LD and if this is a likely situation to occur

in reality.

Exercise 4.13 (A case of sibship revisited).
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In the second exercise we revisit the example in Exercise 4.2 concerning

disputed sibship. Two females, F1 and F2, are interested to find out whether

they are siblings in some way. We specify hypotheses

H1: F1 and F2 are full siblings

H2: F1 and F2 are maternal half siblings

H3: F1 and F2 are paternal half siblings

H4: F1 and F2 are unrelated

a) Explain why we may distinguishH2 fromH3 with X-chromosomal markers

but not with autosomal markers.

b) Use the same frequency data, and haplotype observations, as in Exer-

cise 4.12, alternatively open the file Exercise4 13.sav.

c) Specify λ = 0.0001 and select the relevant hypotheses. Note: if you also

stored the case-related DNA data in the previous exercise, you may be

asked if you wish to erase all DNA data, answer yes.

d) Enter data for both F1 and F2 as 12/12 for L1 and 17/17 for L2. Calculate

the LR Scale against H4. Comment on the importance of accounting for

LD and linkage in the current case.

Exercise 4.14 (On the importance of λ).

This exercise is intended to provide some insight into how the haplotype

frequencies are estimated and the importance of the parameter λ. Our model
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for haplotype frequency estimation is described by

Fi =
ci + piλ

C + λ
(4.13)

where Fi is the haplotype frequency for haplotype i, ci is the number of obser-

vations for the haplotype, pi is the expected haplotype frequency (assuming

linkage equilibrium) calculated using the unconditional allele frequencies, C

is the total number of observations for all haplotypes and λ is a parameter

giving weight to the expected haplotype frequencies. This model allows for

unobserved haplotypes to be accounted for, in contrast to models which esti-

mate the haplotype frequency solely based on the counts. The difficulty lies

in the choice of a good λ. Our recommendation is to compute the LR for a

number of different values and select the least extreme value, i.e., the value

closest to 1.

To start, we specify a case with an aunt of a female child

H1 : The female is the aunt of the child.

H2 : The two females are unrelated.

a) Again use the same frequency data as in Exercise 4.12. Select the relevant

hypotheses. Hint : Select the Aunt/Uncle as the main hypothesis.

b) Enter data for the child as 12/12 for L1 and 16/17 for L2 and for the aunt

as 12/13 for L1 and 17/17 for L2.

c) Calculate the LR for d λ = 0.0001, 0.01, 1, 100 and 10000.

d) What happens for large and small values of λ? Hint : use the equation

for haplotype frequency estimation above.
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e) Change the data for the child to 13/13 for L1. Repeat c) and discuss the

results.

Exercise 4.15 (Extended example. Combining Familias, FamLinkX).

This exercise provides a challenge where the user needs to combine the results

from Familias and FamLinkX to obtain a final result. The data is extracted

from a real case (anonymized) where three females provided DNA samples.

The hypotheses are

H1 : The three females are all full siblings.

H2 : Any other pedigree constellations.

Obviously H2 cannot be used in the current setting, in a simple way, and we

need to refine possibly alternative hypotheses. a), b) and c) involve the use

of Familias, however you may also skip to d) for FamLinkX.

a) * Open the file Exercise4 15.fam in Familias 3. We may assume that

all females are children with no children of their own. Specify that the

three females are children. Also define two parents, a mother and a father

and specify that they are both born 1970.

b) * Use Familias (Generate pedigrees) to find the pedigrees with a poste-

rior probability above 0.001. Which are the most probable relationships

according to the results? Interpret the results.

c) * Discuss the constraints specified in a) and their impact on the results

in b)
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d) Open the database Exercise4 15.sav in FamLinkX, which contains fre-

quency and haplotype data for the Argus X12 kit from QIAGEN based on

a Swedish population sample. Explore the haplotype frequency database.

e) Based on the results in b), we specify the hypotheses

H1 : The three females are all full siblings

H2 : Two females are full siblings and the third (named F3) is a paternal

half sibling

H3 : Two females are full siblings and the third (named F3) is a maternal

half sibling

f) Import the DNA data, available in Exerecise4 15.txt. Make sure to

import the data in the file to the correct corresponding persons, the person

denoted F3 should be imported to 3.

g) Calculate the LR and interpret the results. Be patient, the computation

may require some time >20 min. Hint : To speed the computations up,

go into File->Advanced, select and edit the hypothesis we have selected

to investigate. For each pedigree set the Threshold value to 0.001 and

the Steps value to 0.

h) Discuss if the LR in g) may be combined with the results in b)? What is

your final conclusion on the case?

Exercise 4.16 (Further discussion of λ).

We will provide an example of how the value of λ may crucial to the con-

clusion in a case. We use anonymized data from a real case with two typed

females (F1 and F2) and consider hypotheses
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H1 : F1 and F2 are paternal half siblings, with different mothers.

H2 : The two females are unrelated.

a) Open the file Exercise4 16.sav, containing the frequency database.

b) Select appropriate pedigrees and import genotype data from the file Ex-

ercise4 16.txt.

c) Compute the LR for a number of different values on λ, e.g., 0.001, 1, 100

and 1000.

d) Discuss the results in c). What conclusion can be drawn?

e) * Explore the genotype data and see if you can find an answer to the

results. Use your knowledge about haplotype phases under the different

hypotheses. Hint : Use the frequency estimation tool in the Edit cluster

dialog.

f) Discuss what value on λ should be chosen. What is most conservative?
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5.2 Exercises

Exercise 5.1 (Introduction to R Familias. Video). We begin with com-
putations for a simple paternity case, in order to illustrate the use of the
Familias package, and compare it with computations by hand.

a) Consider a paternity case where observations have been made at only one
locus. The possible alleles at that locus are denoted A, B, C, and D, with
population frequencies 0.1, 0.2, 0.3, and 0.4, respectively. The observed
genotypes for the mother, child, and alledged father (AF) are A/B, A/C,
and C/D, respectively. Disregarding any kind of complexities, like popu-
lation substructure, frequency uncertainties, and mutations, compute by
hand the likelihood ratio in favor of paternity.

b) Use R to run the following code:

# Start the Familias package

# It must be already downloaded with e.g.

# install.packages("Familias")

library(Familias)

# Define the persons involved in a standard paternity case:

persons <- c("mother", "child", "AF")

sex <- c("female", "female", "male")

# Define the two alternative pedigrees:

ped1 <- FamiliasPedigree(id = persons, dadid = c(NA, "AF", NA),

momid = c(NA, "mother", NA), sex=sex)

ped2 <- FamiliasPedigree(id = persons, dadid = c(NA, NA, NA),

momid = c(NA, "mother", NA), sex = sex)

pedigrees <- list(notFather = ped2, isFather = ped1)

# Note that the package by default will compute LR’s using

# the first listed pedigree in the denominator, so notFather

# should be listed first to obtain the same result

# as in the manual calculation.

# Define a marker with four alleles with the given frequencies:

frequencies <- c(0.1, 0.2, 0.3, 0.4)

allelenames <- c("A", "B", "C", "D")

theg
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marker <- FamiliasLocus(frequencies, allelenames)

# List the observed data

mother <- c("A", "B")

child <- c("A", "C")

AF <- c("C", "D")

datamatrix <- rbind(mother, child, AF)

# Note how the commands above create a matrix with the

# row names equal to the names of the persons involved.

#Compute the posteriors and likelihoods:

result <- FamiliasPosterior(pedigrees, marker, datamatrix)

Now, write result in R, and interpret the information in the result object
created with the commands above. Use the command
help(FamiliasPosterior) for help with interpreting the output. Check
that you get the same result as you computed manually above.

c) The remains of a man has been found, and it is speculated it is the miss-
ing uncle of two (full) brothers. More precisely, if we call the remains
“body” and the two brothers B1 and B2, the hypothesis is that the fa-
ther of B1 and B2, let us call him “father”, is the full brother of “body”,
whereas the counter-hypothesis is that “body” is completely unrelated to
B1 and B2. Write R-code as above to specify the two alternative pedi-
grees: In addition to “body”, B1, B2, and “father”, you should in both
pedigrees include the persons “mother” (of B1 and B2), and “grandma”
and “grandpa”. Hint : Use help(FamiliasPedigree) to understand how
to formulate the input for this function.

d) Assume DNA data for the same locus as above has been obtained, and
that one has observed A/A, A/B, and A/C for the body, B1, and B2,
respectively. Use the FamiliasPosterior function to compute the LR in
favor of the body being the missing uncle.

e) In our simple context, where we assume that mutations are impossible,
there are exactly 5 different genotypes “father” could have. Find these.
Then, for each of them, add it as observed data, and compute the like-
lihood of the two pedigrees using FamiliasPosterior. Show that the
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Exercise 6.3 (Dropout rates). In Subsection 6.9 a simple model for dropouts 
was described, where each allele in the genotype has an independent probabil-
ity d of not being observed in the data. As mentioned, when the observed data 
is heterozygote, dropouts cannot have occurred, while if the data is homozy-
gote, there is a certain probability that a dropout has occurred. However, it 
is important to notice that this probability is not equal to the probability d.

a) Assume one has made the observation a/a∗ for a marker in which the
allele a has population frequency pa. Let D be a variable which has
possible values 0, 1, and 2 according to whether there has been 0, 1, or 2
dropouts at the marker. Use Bayes formula to compute the formula for
Pr(D = 1 | data = a/a∗) in terms of d and pa. What will happen with
this probability when pa approaches zero?

b) When the observation is a/a∗ there are two possibilities for the actual
genotype: That it is homozygote a/a, or that it is heterozygote a/b,
with b 6= a. Use Bayes formula to compute a formula for the probability
Pr(heterozygote | data = a/a∗) in terms of d and pa.

Exercise 6.4 (*Inbreeding. Jacquard. paramlink). In this exercise we
look at Jacquard’s condensed identity states Σ1, . . . ,Σ9, which describe the
possible IBD patterns between two individuals, see Section 6.4.1. These
states are illustrated in the second row of Figure 6.5. The names of the
states are given in the first row of the figure.

Given a pedigree connecting two persons, it will induce a probability
distribution on the 9 possible identity states. We defined

∆i = Pr(Σi | P)
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in Section 6.4.1 for a pedigree P . The R functions below are found in the
package paramlink.

a) Explain why ∆1 = . . . = ∆6 = 0 when the individuals X and Y are not
inbred.

We now assume our marker has two alleles, a and b, with population fre-
quencies p and q = 1 − p respectively. Any individual then has one of the
three genotypes g1 = a/a, g2 = a/b and g3 = b/b. For a pair of individuals
X and Y with genotypes GX and GY there are then 9 possible combinations
of genotypes. Given a pedigree P and the alleles with population frequen-
cies above, we get a probability distribution on these possible genotypes. Let
d(P) denote the 3×3 matrix with entries dij(P) = Pr(GX = gi, GY = gj | P).
We then get

dij(P) =
9∑

k=1

Pr(GX = gi, GY = gj,Σk | P)

=
9∑

k=1

Pr(GX = gi, GY = gj | Σk) Pr(Σk | P) =
9∑

k=1

dij(Σk)∆k

b) For non–inbred pairs of individuals, the following three distributions are
particularly important:

UN := d(Σ9) = d(X and Y are unrelated),

PO := d(Σ8) = d( X and Y are parent–offspring),

MZ := d(Σ7) = d(X and Y are monozygotic twins).

Assume X and Y are full sibs. Verify that

d(P) = 1
4
UN + 1

2
PO + 1

4
MZ

and that

d1,1(P) = 1
4
p2(p2 + 2p+ 1). (6.24)

The remainder of this exercise addresses a problem involving an inbred
pairwise relationship. The hypotheses are:

H1 : The individuals are full brothers whose parents are full sibs.
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H2 : The individuals are full brothers with unrelated parents.

For H1 (see below):

∆ =

(
2

32
,

1

32
,

4

32
,

1

32
,

4

32
,

1

32
,

7

32
,
10

32
,

2

32

)
, (6.25)

while for H2

∆ =

(
0, 0, 0, 0, 0, 0,

1

4
,
1

2
,
1

4

)
. (6.26)

Assume both individuals are homozygous a/a.

c) Create and plot the pedigrees corresponding to H1 and H2 with geno-
types indicated.

d) Let p = 0.1. Use oneMarkerDistribution to verify that the distribu-
tion for the genotypes assuming H1 is as given in Table 6.2.

e) Show that the likelihood for H1 is

Pr(data | H1) =
1

16
(1 + 8p+ 6p2 + p3)p

f) Derive

LR(p) =
Pr(data | H1)

Pr(data | H2)
=

1

4

1 + 8p+ 6p2 + p3

p+ 2p2 + p3
. (6.27)

Verify that limp→0+ LR(p) = ∞, LR(1) = 1 and LR(p) ≥ 1. Plot
log10 LR(p) for p ∈ [0.001, 0.1].

g) Suppose one of the brothers is a/a; the other is not typed. Find the
conditional probability for the genotypes of the other brother using the
oneMarkerDistribution. Also explain how the result could have been
obtained from Table 6.2.

i) The function markerSim implements simulation allowing for general
conditioning and complex pedigrees. Use markerSim to check the exact
calculations above.
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a/a b/b a/b

a/a 0.0116 0.0061 0.0147

b/b 0.0061 0.7756 0.0507

a/b 0.0147 0.0507 0.0695

Table 6.2: Table for Exercise 5.3.

Exercise 6.5 (Jacquard coefficients. identity).

a) Use the R package identity to calculate the condensed identity coeffi-
cients ∆ given in (6.25) and (6.26).

b) A father has a son by his own daughter. Find ∆ and calculate the likeli-
hood when father and son both are a/a for a SNP-marker with frequency
p = 0.1 for the a allele using (6.24). Use Familias or paramlink to
confirm the answer.
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Exercise 8.3 (*LR as a random variable. paramlink). The likelihood ratio
can in some circumstances be treated as a random variable as discussed
in Section 8.2 and exemplified below.

Consider a single diallelic marker. The alleles are denoted a and b and the
frequencies are p and 1−p. For the numerical examples p = 0.5. In this case
we let H1 state that there is a parent-child relationship between AF and
CH, and H2 that they are unrelated. Throughout we make the standard
simplifying assumptions: Hardy – Weinberg equilibrium, no mutations, no
silent alleles nor genotyping error.

a) Show that

Pr(GAF = a/a,GCH = b/b | H2) = p2(1− p)2 = 0.0625.

Note that the probability of the same event under H1 is 0.

b) Use paramlink to obtain the complete distribution ofGAF andGCH under
H1 and H2 given in Tables 8.6 and 8.7.

a/a b/b a/b
a/a 0.1250 0.0000 0.1250
b/b 0.0000 0.1250 0.1250
a/b 0.1250 0.1250 0.2500

Table 8.6: The distribution of GAF (rows) and GCH under H1 requested in
Exercise 8.3

a/a b/b a/b
a/a 0.0625 0.0625 0.1250
b/b 0.0625 0.0625 0.1250
a/b 0.1250 0.1250 0.2500

Table 8.7: The joint distribution of GAF (rows) and GCH under H2 requested
in Exercise 8.3

c) Find Pr(X1 = 0) and Pr(X2 = 0).

d) Reproduce Table 8.8.
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x Pr(X1 = x) Pr(X2 = x)
0 0 0.125
1 0.75 0.75
2 0.25 0.125

Table 8.8: The distribution of LR under H2 and H1 requested in Exercise 8.3

e) Verify (8.5)

E(X−1
1 ) = Pr(X2 > 0)

based on Table 8.8.

Exercise 8.4 (Expectation of LR). The previous exercise is continued by
considering expected values of LR.

a) Show that E[X1] = 1.25 and E[X2] = 1 based on Table 8.8. Calculate
E[X1] once more, this time using (8.6), also given as Eq (15) in Slooten and
Egeland (2015, Int J Legal Medicine).

b) Consider two pedigrees, Ped1 and Ped2, specifying non–inbred pairwise
relationships. Assume that for Ped1, there is a positive probability that the
individuals share two alleles IBD while this probability is 0 for Ped2.
Explain why the expected LR for ped1 is greater than the one for Ped2 for a
marker containing a sufficient number of alleles (in both cases the
numerator LR specifies the individuals to be unrelated).

Exercise 8.5 (*Exclusion power. Simulation. paramlink). This exercise 
deals with the power of exclusion as implemented in the paramlink function 
exclusionPower. The methods and implementation are described in [49], 
Egeland, Pinto and Vigeland (2014) and we briefly review the notation. It 
suffices to consider one marker as in-dependence is assumed. There are N 
individuals with a claimed relationship described by a pedigree Ped1. 
Typically there will be more than N indi-viduals in Ped1 as additional persons 
may be needed to define the family relationships. We assume that all N will be 
available for genotyping, but we allow for situations where some genotypes are 
known from previous genotyp-ing (all analyzes are then conditional on these). 
If the true relationship is described by Ped2, the marker’s power of exclusion is 
defined as:
PE = 1−RMNE = Pr(Ped1 incompatible with genotypes |Ped2). (8.11)



288 CHAPTER 8. MAKING DECISIONS

a) Consider first a standard paternity case and a SNP marker with allele
frequencies p and 1−p. No individuals are genotyped, but genotype data
will eventually be available from the alleged father and the child. Show
that PE = 2p2(1− p)2. Check the formula for p = 0.2 by entering

require(paramlink)

claim <- nuclearPed(noffs = 1, sex = 2)

true <- list(singleton(id = 1, sex = 1), singleton(id = 3,

sex = 2))

available <- c(1, 3)

exclusionPower(claim, true, available,

alleles = 2, afreq = c(0.2, 1-0.2))

Observe that a plot is produced by default.

b) Assume the child is known to have genotype 1/1. Calculate PE for this
case.

c) Do problem a) above when the marker is on the X-chromosome.

d) Repeat the above exercises for a marker with allele frequencies 0.7, 0.1,
0.1 and 0.1.

Next, consider a more complicated example: Two females claim to be
mother and daughter. Below we compute the power to reject this claim
if they in reality are sisters for a SNP marker.

e) Define the pedigrees by typing

mother.daughter <- nuclearPed(1, sex = 2)

sisters <- relabel(nuclearPed(2, sex = c(2, 2)),

c(101, 102, 2, 3))

Calculate the probability of exclusion for an equifrequent SNP marker.

f) Consider next an extreme case of inbreeding corresponding to the parents
being full sibs. Calculate the power of exclusion by entering

sisters.LOOP <- addParents(sisters, 101, father = 201,

mother = 202)
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sisters.LOOP <- addParents(sisters.LOOP, 102, father = 201,

mother = 203)

exclusionPower(ped_claim = mother.daughter,

ped_true = sisters.LOOP, loop = 101,

ids = c(2, 3), alleles = 2)

Assume the minor allele frequency is 0.1 and that one of the sisters, say 3,
is homozygous for the minor allele. Redo the last calculation.

Exercise 8.6 (Conditional simulation paramlink).

a) The function markerSim of paramlink can be used to simulate marker
data as explained in 8.12. In this exercise we consider two genotyped
brothers and we would like to simulate genotypes for their parents. Enter
the following commands to perform five simulations based on the marker
SE33 of the database NorwegianFrequencies assuming the brothers are
11/12 and 12/13

x <- nuclearPed(2, sex=1)

data(NorwegianFrequencies)

L1 <- NorwegianFrequencies[["SE33"]]

m <- marker(x, alleles=names(L1), afreq=L1,

3, c(11,12), 4, c(12,13))

simPed <- markerSim(x, N=5, available = c(1,2),

partialmarker = m, seed = 17,verbose=FALSE)

b) Plot the pedigree with genotypes indicated.
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